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Welcome to Multi-Ad ™! Multi-Ad Services has
a tradition of providing fast, reliable, intuitive, and pow-
erful software. It has provided desktop layout software—
like Creator®—to newspapers and advertisers for years.

is no exception.

contains a host of features that helps make
documentation layout quicker, easier, and more creative.
Multi-Ad has all the features you require,
whatever your documentation needs. These features
include:

• Multiple pages

• Multiple Master pages

• Different page sizes in one document

• Unlimited Undos

• Zoom to 800 percent

• Ability to contain elements inside one another

• Converting text into a path

• Style Models that let you easily apply complex,
repetitive styles to text and graphics

• The ability to duplicate elements at specified loca-
tions and sizes, or to create matrices of elements

• Advanced text features. For example kerning to
1/1000 of an em and support for Multiple Master
and TrueType GX fonts

• Automatic generation of masks

• Gradients of more than two colors

• Textures and border graphics

WELCOME TO MULTI-AD CREATOR2®!
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• Placement of EPS, TIFF, PICT, JPEG, GIF and
other graphic file formats

• Multiple open windows of same document

• A fully scriptable interface

Whatever your design needs, gives you the
most powerful set of tools and features available without
sacrificing ease of use. We hope you enjoy using

. If you have any questions or comments please
let us know!

INSTALLATION INSTRUCTIONS
Read the following installation instructions carefully.
These instructions provide helpful information about

’s hardware and software requirements. In
addition, requires certain software in order to
run. You can find a list of the applications, control panels,
and extensions loads onto your computer.

Hardware guidelines and recommendations
Component

Computer

Available memory

Operating system

Minimum

Macintosh with a
68040 processor
or better

16MB

System 7.5.5

Recommended

Power Macintosh
or Performa with
a PowerPC
processor

More is better

Other:

• GX Graphics 1.1.3 extension

• ATM 4.0.2 or later

• ColorSync 2.1

• Mac Easy Open

• Type 1 Enabler 2.5 or later

• GXifier 1.3 or later

• PostScript and/or QuickDraw printer
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Note: Do not increase the amount of memory allocated to
unless you recieve a dialog box that

expressly tells you to do so. The Macintosh OS
allocates memory expressly for the GX Graphics
extension, which provides advanced graphic and
typography capabilities. Increasing the applica-
tion memory might affect QuickDraw GX.

Installing Creator2
To install , place the CD in the CD-
ROM drive on your computer.

Note: If you need to install from floppy disks,
contact Multi-Ad Services at (309) 692-1530 and
ask for the department..

Before you begin installing , first make sure
that you have no applications running. 

1. Open the Creator2 Installer folder on the
Creator2 CD .

2. Double-click on the Multi-Ad Creator2 Installer
application icon. The Creator2 Introduction screen
appears.
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3. Click the Continue… button. The Installation
Notes screen appears. 

Read the screen carefully. It contains important
notes about the installation process, the applica-
tion’s hardware and software requirements, and
other information. You can print the installation
notes by clicking the Print… button. You can also
save the notes as a text file by clicking the Save
As… button and opening a directory dialog box.

4. Click the Continue button. The Installation screen
appears.



5. Choose the type of install you want from the
Install pop-up menu in the upper left corner of the
Installation screen. You can choose from Easy
Install , Custom Install , and Remove options.

The Easy Install option automatically installs all
of the needed extensions, utilities, and compo-
nents of . The Custom Install option
lets you choose which of ’s components
you want to install on your computer in the scroll
list below the pop-up menu.

For both the Easy Install and Custom Install
options, the Installer displays your available hard
drive space and the hard drive space you need for
installation below the scroll list.

The Remove option lets you uninstall the
application and its required exten-

sions and utilities from your computer.

To review ’s hardware and software
requirements, click the Read Me… button to
return to the Installation Notes screen.

5Creator2 Getting Started Guide



6. Click the Select Folder button to open the
Installer’s directory dialog box.

Use the directory dialog box to navigate to the
folder where you want to place the 
application. Click the Select button to choose the
folder and return to the Installation screen.

7. Click the Install button to begin the 
installation process. Click the Quit button to exit
the Installer application and return to the Finder.

If you click the Install button, a progress bar
appears. 

This progress bar notifies you of each item placed
on your Macintosh. To stop the installation
process, click the Stop button.

Creator2 Getting Started Guide6
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A dialog box appears to notify you of the success-
ful completion of the installation process.

8. Click the Restart button to reset your computer
in order to use . If you wish to install
additional items, click the Continue button. To
exit the Installer and return to the Finder, click
the Quit button.

After you have installed and restarted your
Macintosh, locate the folder containing the 
application. Before launching the application, make sure
you have your registration materials on hand.

1. Double-click the application icon. The
application launches and the Creator2
Registration screen appears.

2. Enter your name, your company name, and the
serial number for your copy of into the
appropriate text fields. Click the OK button to
enter the application. Only a registered version of

enables all the application’s features.

Note: notifies you if you enter an
incorrect serial number and prompts you
for your number again.
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If you want to view a demonstration version of
the application, click the Demo Once button. The
demonstration version of disables
some application features, such as the Save com-
mand. If you only intend to use a demonstration
version of and do not want the
Registration screen to appear again, click the
Demo Always button.

Note: If you click the Demo Always button you
cannot register your version of

… ever!

To exit the application entirely, click the Quit
button.

After you have registered your copy of (or
selected the demonstration version), the Creator2 Start-
up screen appears. You can now begin using the

application.
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Files placed during installation

During installation, the Installer places the 
application and its support files into specific folders. The
following list provides the location of those files after
installation.

In the Creator2 folder:

• Multi-Ad 

• Creator2 Add-ons folder

♦ Border Files folder

♦ Color Lists folder

♦ Dictionaries folder

♦ Texture Files folder

• GXifier 1.3 or later

• Type 1 Enabler 2.5 or later

In the System folder:

• Adobe Type Manager (ATM) 4.0.2 (in the Control
Panels folder)

• ColorSync 2.1 or later (in the Ex tensions folder)

• GX Graphics 1.1.3 or later (in the Ex t ensions folder)
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Saving documents

One of the most important things you need to know how
to do is to save your documents for later use. Like all
Macintosh applications, this is accomplished through the
Save or Save As… commands in the File menu.
Whenever you want to preserve a document, choose the
Save command. The first time you choose the Save com-
mand in a new document, a directory dialog box opens.

The directory dialog box lets you navigate through the con-
tents of any mounted storage device, like a hard drive.
Think of the Macintosh as a filing cabinet. Each drawer of
the cabinet contains a number of folders, each folder repre-
sents a topic. One of these topic folders itself may contain
more folders, each of these folders represents a subtopic. 

WORKING IN MULTI-AD CREATOR2
As a first time user, you may find yourself
slightly overwhelmed by the sheer number of options and
features of the application. Don't panic, 
shares many features with other Macintosh programs. If
you haven't used a Macintosh extensively, this training
manual introduces the basic features of the program and,
as your familiarity with the interface develops, walks you
through more complex features.

Should you have additional questions about any the con-
cepts or features discussed in this manual, refer to the
appropriate Macintosh documentation, the Multi-Ad

User's Guide, or the Multi-Ad 
Reference Manual.
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To display the contents of a folder that appears in the
dialog box's scroll list, double-click on that folder's icon.

Click on the pop-up menu above the scroll list to move up
to higher level folders. Clicking the Desktop button takes
you to the highest filing level on the Macintosh. Using
these features you can navigate throughout your comput-
er's filing system.

Locate and open the folder you want to save your file in.
Then Type the name of the file into the Save the document
as text field. Finally, click the Save button. A watch
appears on screen as your computer saves the file. When it's
all finished, your computer returns you to the Document
Window. Notice that the name on the Document Window's
Title Bar is now the same name you saved the document as.

Now each time you choose the Save command, 
automatically saves that document with the name you
selected. The application replaces older versions of docu-
ments with the selected name with newer versions. 

If you always want to open the Save dialog box before sav-
ing a file, choose the Save As… command in the File menu.
The Save As… command lets you rename a file or save a
file in a different place each time you save. This lets you
make backup copies of documents or save older copies of a
document. To preserve older copies of a document, add a
number or the current date each time you save a docu-
ment. 

You can also make backup copies by selecting the Keep
backup when saving check box in the General panel of the
Preferences dialog box in the Edit menu. For more infor-
mation, see the Preferences… command entry in the Edit
menu section of the Reference Manual.
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To send a document to the printer, you need to use the
Print… command in the File menu. Choosing the Print…
command opens the Print dialog box. The appearance of
the Print dialog box varies according to the printer driver
you are using. This manual uses the LaserWriter 8.4.2
printer driver to illustrate printing features.

Although the Print dialog box contains a variety of differ-
ent panels, you can print a document from any panel
simply by clicking the Print button. Each panel lets you

Printing documents

To open a saved file, simply choose the Open… command
in the File menu, this opens the Open directory dialog box.
You navigate the Macintosh filing system using the Open
directory dialog box in just the same way as you do in the
Save directory dialog box. Choose a folder from the pop-
up menu to leave the currently displayed folder and dou-
ble-click on a folder, or click on a folder and then click the
Open button, to display the contents of a selected folder.

Use the directory dialog box to locate your saved file.
Double-click on the file, or click on the file and then click
the Open button, to place the file into .

Note: As you work on the exercises in the coming sec-
tions, it is a good idea for you to regularly save
your work. That way, you can always pick up
from your last save should you lose power, the
computer crashes, or some other problem occurs.
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access a different set of printing attributes. You can
choose a panel from the Panel pop-up menu. If you’re only
printing proofs of a document, you may only need to
adjust the settings in the General panel.

The General panel of the Print dialog box contains the main
printing attributes. Here, you can tell how many
times you want to print your document, the pages you want
to print, and what paper the document should print on. 

Enter the number of times you want to print your docu-
ment into the Copies text field. Click on the All radio but-
ton if you want to print your entire document or click the
From radio button if you just want to print certain pages.
(Enter the page range in the From and To text fields.) 

Click the All pages from radio button if you want all the
pages in your document to print on paper from the paper
tray selected in the pop-up menu. Click the First page
from radio button if you want the first page of your docu-
ment to appear on paper from a specified print tray.
Notice that the First page from radio button activates the
Remaining from pop-up menu. Use this menu to choose
the paper tray containing the paper you want the rest of
your document to print on.

The ability to print documents on different size sheets of
paper can prove helpful, especially in .

lets you create documents of any page size,
even sizes that you don't have in your printer's paper
trays. To help you distinquish between the document's
page size and the printer's paper size, places
several rectangles in your Document Window.
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The white area centered in the Document Window is, of
course, your document's page size. However, this can be
both larger and smaller than your printer's paper. The
blue outer rectangle represents the sheet size in the
selected paper tray. The red inner rectangle represents
the printable area of the selected paper size.

If you intend to use the same print settings repeatedly,
click the Save Settings button. This tells to
remember the print attributes for the current document.
Everytime you print that document, uses the
specified print settings.

Paper size

Paper's printable
area

Document
page size
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treats all elements placed into a document the
same. This means you can manipulate items as diverse
as graphics, starbursts and rectangles in similar ways.
Text blocks are even considered elements. You can move
them freely about the screen, resize them at will, or edit
their appearance on a whim.

Drawing elements

In this sections, we will discuss how to create—or draw—
elements like rectangles, ovals, and starbursts. These
elements are all made in , as opposed to being
imported into the program from an outside file. Each of
the elements you can draw in appears on an
icon on the Tools palette.

To draw a shape, you simply need to click on the icon of
the desired shape, move your pointer into the Document
Window, and then click and drag the shape. For an exam-
ple, let's draw an oval.

Working with elements

Text tool

Rectangle
tool

Starburst
tool

Freehand
Drawing tool

Path
tool

Border tool

Line tool

Oval
tool
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1. Click on the Oval tool on the Tools palette.

2. Move the pointer to the Document Window.
Notice that the pointer has changed into a
crosshair.

3. Click and drag to form an oval. Notice that the
longer the drag, the larger the oval.

4. Release the mouse button once you have drawn
the oval to the desired size and shape. You have
finished drawing your element.

You can draw any element in the same manner. The
drawing method in remains the same if you
are drawing ovals, squares, or freehand drawings. If you
press the Shif t key while drawing an element, 
draw as the object proportionally. This lets you create
squares and circles.

Modifying elements

Even after you have drawn an element, you still have the
ability to change its size, its shape, or its position on the
page. You can do this by using the Arrow tool on the Tools
palette. There are several other tools on the Tools palette

+

+

+
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that also let you modify the appearance or positon of an
element. These tools include: the Rotate tool, the Skew
tool, and the Flip tool.

However, the Arrow tool has the greatest number of uses
and is probably the tool you will use most frequently. You
can use the Arrow tool to move elements.

1. Click on the Arrow tool on the Tools palette.

2. Click on the oval element. Notice that black han-
dles appear on the sides and corners of an invisi-
ble rectanglular frame surrounding the oval. 

3. Move your pointer inside the shape of the oval
and then click and drag on the oval. A shadow of
the oval appears beneath your pointer.

4. Drag the shadow to where you want the oval to
appear on the page. 

5. Release the mouse button to place the oval in the
desired spot.

You can also use the Arrow tool to resize an element. To
resize your oval, complete the following steps.

1. Click on the Arrow tool on the Tools palette.

2. Click on the oval element. Black handles appear
on the sides and corners of an invisible rectanglu-
lar frame surrounding the oval. 

3. Move the arrow pointer over one of the handles.
The pointer becomes pinching fingers. 

Arrow tool

Skew tool

Rotate tool

Flip tool
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4. Click and drag on a handle. Clicking a side han-
dle lets you resize one side of the oval. Clicking a
corner handle lets you resize two sides of the oval
at once.

In this instance, we have resized the oval making
it slightly longer and considerably narrower than
the original element.

5. Release the mouse button to resize the oval at the
desired dimensions.

You can resize the oval proportionally by pressing the
Shif t key while dragging on a handle.

Using the Rotate tool

Should you want to rotate an element around a particu-
lar point, you need to use the Rotate tool. The Rotate
tool, like the Arrow tool, is extremely easy to use.

1. Click on the Rotate tool on the Tools palette.

2. Move your pointer to the Document Window.
Notice the pointer becomes an arrow on a curved
line.

3. Click on the element you want to rotate. Again,
we'll use the oval as an example.
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4. Click on one of the oval's handles and drag in the
direction you want to rotate it. Notice that a shad-
ow of the oval appears to indicate the specific
degree of rotation.

5. Release the mouse button to rotate the oval to the
desired degree.

Using the Skew tool

Should you want to angle the sides of an element, you
need to use the Skew tool. This time, however, we won't
use the oval as an example. Draw a rectangle, if you have
any questions refer to the section on Drawing elements.

1. Click on the Skew tool on the Tools palette.

2. Move your pointer to the Document Window.
Notice the pointer becomes a crosshair.

3. Click on the element you want to skew. This
should be the rectangle you just created.
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4. Click on one of the rectangle's handles and drag
in the direction you want to angle it. Notice that
a shadow of the rectangle appears to indicate the
amount of skew.

5. Release the mouse button to skew the rectangle
the desired amount.

Using the Flip tool

Should you want to flip an element along its horizontal
or vertical axis, you need to use the Flip tool. As with the
last example, this one uses a rectangle.

1. Click on the Flip tool on the Tools palette.

2. Move your pointer to the Document Window.
Notice the arrow becomes a flip pointer.

3. Click on the element you want to flip. This should
be the rectangle you just created.
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You may find working with text a bit more complicated
than working with elements. This may be due to the fact
that text appears inside elements called text blocks. This
may imply a longer process than anything you've done
before. Don't worry; text and elements have many simu-
larities. Much of what you have already learned you can
apply to text.

To begin with, treats all objects as elements,
whether they be text blocks or ovals. This means you can
use all the skills you've learned in all the same ways. You
can resize, move, flip, and skew a text block just like any
other element. Even creating text blocks should seem
familiar.

1. Click on the Text tool on the Tools palette.

Working with Text

4. Click on one of the rectangle's handles and drag.
A shadow of the rectangle appears to indicate the
direction and orientation of the flip. Notice that
you cannot flip an element at its point or origin.

5. Release the mouse button to flip the rectangle.
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2. Move the pointer to the Document Window.
Notice that the pointer has changed into a
crosshair.

3. Click and drag to form a text block. 

4. Release the mouse button after the text block is
the desired size. You have finished drawing your
text block.

After you have created a text block you can modify it nor-
mally using the Arrow, Flip, or other tools. You may
notice, however, a box in the lower right corner of the
text block when you select it with the Text tool. This is a
widget. An I-beam appears when you position your point-
er inside the text block. A blinking line in the upper left
corner of the text block also appears. This is called the
insertion point.

Insertion point

Widget

!

I-beam cursor
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The presence of the insertion point indicates that what-
ever you type on the keyboard appears inside the text
block. If you decide to change the text after you have
begun typing, you can make the desired changes using
the I-beam. Position the I-beam over the desired text and
then click and drag. Notice the text you drag over
becomes highlighted. Any changes you make affect the
highlighted text.

You can keep typing until you fill up all the available
space in the text block. If you run out of space, you have
several options. You can resize the text block with the
Arrow tool, or you use the widget method. 

You may notice that when you overrun the boundaries of
a text block the symbol in the block's widget changes
from an exclamation mark (!) to an ellipsis (…). The
exclamation mark serves to tell you that all the block's
text is visible while an ellipsis tells you that more text
exists than can be viewed in the block. 

If you click on an ellipsis widget with your pointer, it
changes into A+…, this means that the extra text has
been loaded into your pointer. Now, if you click and drag
in the Document Window, you draw a new text block that
automatically contains the remaining text. You can click
on a widget and draw text blocks until all the contained
text is displayed. 
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Notice that the widget of the first block you created now
contains a 1, and the widget of the second block a 2, and
so on. The widgets now display the order of the blocks.

Moreover, the blocks are linked so you can click in one
block for the insertion point and then use the arrow keys
to move between blocks. Of course this means that
changes to one linked block may also change the content
of all following text blocks.

Note: The insertion point and the widget only appear if
you click on a text block with the Text tool.

Now, are you ready to make use of all that information?
We'll go slowly.

1. Click on the Text tool on the Tools palette.

2. Draw a text block in the Document Window.
Notice the blinking insertion point in the upper
left hand corner of the text block.

3. Type:

A foolish consistency is the hobgoblin of
little minds, adored by little statesmen
and philosophers and divines. With consis -
t ency a great soul has simply nothing t o
do. <Return>

Ralph Waldo Emerson <Shift-return>
"Meditation XVII" <Shift-return>
Devotions upon Emergent Occasions <Shift-
return>

1

2

!
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If the text block cannot contain all the text, resize
the text block using the Arrow tool or click on the
widget with the Text tool and draw another text
block for the remaining text to flow into.

4. Click and drag the I-beam cursor over the first
paragraph, or quad-click to select the whole para-
graph.

Note: Double-clicking with the I-beam selects a word.
Triple-clicking with the I-beam selects a line.
Quad-clicking with the I-beam selects a paragraph.

5. Click and hold the mouse button on the Font
menu at the top of the screen. A listing of fonts
appears. Drag your cursor down the font list.
Each font listing becomes highlighted as the
pointer passes over it.
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6. Release the mouse button when a desired font
becomes highlighted. In this example, the font
Palatino was selected. Notice the typeface of the
selected prargraph changes to reflect the new
font. 

7. Choose the Alignment option from the Format
menu. Notice another menu appears next to the
arrow beside the Alignment listing.

8. Choose the Justify command. Notice that the
highlighted paragraph is now flush on both the
left and right sides of the text block.

9. Hightlight the Devotions upon Emergent
Occasions line.

10. Choose the Underline command from the Style
menu. The selected line now appears underlined.



You should now be familiar with the basics behind styling
text. Feel free to experiment if you like. For example, you
might want to put the quote's reference information in a
smaller type size. Maybe you want to put some space
between the reference information and the left margin.
Simply click to place the insertion point before each line
and then press the Tab key. automatically
moves the text 1/2 inch to the right each time you press
the Tab key.

In the end, your text block may look something like this:

For more information about tabs, see the Text section of
the User’s Guide.

27Creator2 Getting Started Guide
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A QUICKDRAW GX PRIMER
Like many users, you may wonder why an extension
called GX Graphics appears on the installa-
tion CD. The GX Graphics extension lets the application
use QuickDraw GX features.  QuickDraw GX provides
many of the powerful graphic and text features available
in the application. QuickDraw GX software itself, was
designed by Apple to provide advanced graphic, type, and
color features on Macintosh computers.

The following sections provide a brief description of GX’s
capabilities and why uses it. For more infor-
mation on QuickDraw GX, refer to your Apple documen-
tation.

About QuickDraw GX
Apple worked on QuickDraw GX for over five years before
it finally appeared as part of the Macintosh System 7.5
software. The GX Graphics extension adds on to, and
overhauls, the traditional Macintosh graphic and printing
interface. 

However, QuickDraw GX does not replace the traditional
Macintosh graphics engine—QuickDraw. This ensures
compatibility with many existing programs. The level of
compatibility runs so deep, that GX and QuickDraw can
even share certain information.

So what new features did QuickDraw GX bring to the
Macintosh environment? GX added several new compo-
nents, including a new and powerful 2D graphics engine
and enhanced typography features.
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QuickDraw GX Typography features

Another advantage to QuickDraw GX lies in its font tech-
nology. GX provides advanced typography features and
extended character sets for fonts.

By using QuickDraw GX, can automatically
adjust a whole range of font characteristics, like tracking
and justification. GX even allows to substitute
one character for another, if necessary. Of course,

gives you full control over these features so
you can create your own typographical effects.

When creating these typographical effects, QuickDraw
GX lets you use any font available, regardless of format.
It doesn’t matter if you have PostScript Type 1 or
TrueType fonts, GX recognizes all font formats as long as
you have “enabled” (prepared) them. 

If you install PostScript fonts the GX extension has been
installed, you must enable them yourself. To use newly
installed PostScript Type 1 fonts in GX, run the converter
program called Type 1 Enabler. (The Creator2 Installer
places the Type 1 Enabler in the Creator2 application
folder.) You must also remember to install Adobe Type
Manager. GX itself cannot handle PostScript fonts and
relies on ATM to properly display and print Type 1 fonts.

Although GX can use TrueType fonts without any special
preparation, you can add features with the GXifier appli-
cation. can automatically combine certain
characters (for example a and e into æ) when you use
GXified TrueType fonts. As with the Type 1 Enabler, the
Creator2 Installer places a copy of GXifier in the
Creator2 application folder.

To take full advantage of ’s typography fea-
tures, you may want to use GX-specific fonts. These fonts,
designed to work exclusively under QuickDraw GX, offer
an impressive range of features. These fonts often have
extended character sets. An extended set contains fea-
tures—like alternate characters, ligatures, and swash-
es—that you could normally find only in several different
fonts. In addition, you can scale the weight and width of
some GX fonts. 



Creator2 Getting Started Guide30

QuickDraw GX Graphic features

The graphics engine is the strongest feature of
QuickDraw GX, and perhaps the least noticable to the
user. Under GX, the Macintosh describes graphics (even
text) geometrically. Traditional QuickDraw describes
graphics in a 72 dpi bitmap pattern, not by points, lines,
and curves.

The GX geometric graphic engine lets you modify graph-
ics in almost any way. You can create shapes, distort
shapes, or modify shapes by combining them with other
shapes. 

As mentioned above, GX even treats text as graphic
shapes. This feature expands what you can do with text.
For example, in you can expand, slant, even
rotate text blocks. After you modify your text block in this
way, you can even go back and edit its content.
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